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Introduction

I.D.E.E.A. v4.4 overview
I.D.E.E.A. 4.4 adds support to I.D.E.E.A. for the new K71X terminal, together with other 
enhancements and fixes. 

See What’s New in Release 4.4? for full details of changes in this release. 

I.D.E.E.A v4.4 also supports all the features in I.D.E.E.A. v4.0, I.D.E.E.A. 4.1, 
I.D.E.E.A. 4.2 and I.D.E.E.A. 4.3.

Please read the following before installing I.D.E.E.A. v4.4 on your PC:

• I.D.E.E.A. Package Options

• System Requirements

• Before you Install I.D.E.E.A.

• How to Install I.D.E.E.A.

• Frequently Asked Questions

• Fault Reports and Suggestions
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What’s New in Release 4.4?

Summary of changes

Enhancements

Changes to I.D.E.E.A. Workshop
• Support added for K71X-313 and K71X-323 terminals

• Support updated for the K71N-992 terminal

• Keycorp Host Emulator update

Changes to Embedded Components
• Keycorp Host Emulator update

• DrvSct update

Issues fixed
The following issues reported in I.D.E.E.A. v4.3 have been fixed in v4.4.

• Miscellaneous Online help issues fixed - CPR’s #1053, #1099, #1270, #1382, 
#1385, #1407, #1408, #1439, #1440, #1498.
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Support added for  K71X-313 and K71X-323 terminals 
I.D.E.E.A. now provides support for the  K71X-313 and K71X-323 terminals. 

• The BIOS for  K71X-313 and K71X-323 has been added. It supports the following new 
functions related to key creation and encryption. See I.D.E.E.A. help for more detailed 
information about these functions.

• HibSecureRamGenerateKeyBlock - this function allows you to create a random 
single, double or triple DES key, perform checksum, store  the key and checksum 
in a message and encrypt the key with RSA or DES in one step.

• HibDesEncryptKey - this function encrypts a key using another specified DES 
key.

• HibDesKeyOwf - this function creates akey using a one way function.

• Appman libraries and linker templates have been updated to support the  K71X-313 
and K71X-323  products.

• Updated HIB libraries and K71X-313 and K71X-323 topologies support PC simulation 
of the  K71X-313 and K71X-323.

Support updated for the K71N-992 terminal
Support for the K71N-992 terminal has been updated to provide compatibility with K71X-
313 and K71X-323 terminals.

Keycorp Host Emulator update
A new release of the Keycorp Host Emulator, v 3.11, is included with this release of 
I.D.E.E.A. 

Host Emulator Enhancements
• The Transaction Key Management scheme has been updated to be compatible with the 

2000-2004 versions of the AS2805 standard (i.e., using 1024-bit RSA keys for initiali-
sation, and triple-DES with 128-bit keys for all other encryption/authentication opera-
tions).

• The Host Emulator now supports TransAx AS2805 messages.

• The Network Layer tab of the System Configuration dialog now provides for configura-
tion of the IP address on which the Host-Emulator listens for messages.

• The Host Emulator now supports direct communication with a Hypercom NAC using a 
"permanent-mode" connection.

• Online help has been updated and expanded.

Host Emulator Issues fixed
• Previously, when MAC'ing was disabled, bit 64/128 would be set to 0 in the bitmap of 

outgoing messages, but a MAC value would still be appended each outgoing message.

• Previously, if any of the TCP parameters on the Network Layer tab of the System Con-
figuration dialog were changed, all communication with the Host-Emulator would 
cease and would not resume until the Host-Emulator was restarted.

New SrvNet  structure for the K71X modem
The SrvNet component has been updated to include a new connection structure - 
EFT_STRUCT_46, which provides control of the modem in the K71X terminal. See 
I.D.E.E.A. help for more detailed information about this structure. 
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DrvSct update
The DrvSct component has been updated to accommodate a specification change for EMV 
cards and to correct a reported issue. 

• CPR#1381 - for a case4 command, when the status code returned by the card to the 
Get Response command was 90xx (a warning condition such as 9001), the DrvSend-
Apdu function incorrectly returned 9000 as the SW12 status code in the psRApdu 
structure.

• CPR#1477 - previously, if TA2 was not present in the ATR and TA1 was not 0x11, 
DrvSct rejected the ATR. Now, if TA2 is not present in the ATR then TA1 may take any 
(valid) value (i.e. 0x11, 0x12, or 0x13). 

Online help issues fixed
• CPR#1053 - Links to keycorp website within two help topics (About I.D.E.E.A. Online 

Help and Keycorp on the Net) updated - hyperlinks now open the Keycorp website in a 
separate browser window rather than in the help window- while the website opened 
successfully when the link was clicked, navigating to the Ideea Support page caused a 
persistent error message. 

• CPR #1099 –  updated documentation for SrvKFMS to correct incorrect information 
about naming files created with SrvKFMSCreateFile

• CPR #1270 
Added description for new functions in SrvUtil 

• SrvUtilReadConfigurableAlphaNumKeys. 

• SrvUtilRegisterBusyWaitAuxProcFunction 

Added description for new functions in SrvMenu

• SrvMenuRegisterBusyWaitAuxProcFunction 

• CPR#1382 - references to the obsolete I.D.E.E.A. User's Guide were removed from 
the online help. 

• CPR #1385 –  added SrvKFMS functions to index in I.D.E.E.A. help

• CPR #1407 – Citation notice removed from online help project build settings. 

• CPR #1408 – Incorrect formatting of numbered lists in SrvPrn online help corrected.

• CPR #1439 – Help topic for SrvNetIOCtrl updated. Title of help topic corrected. 
Parameter values for bIOType added. Warnings about not using this function for gen-
eral applications made more prominent.

• CPR #1440 - IDEEA help included a topic for a function SrvNetSetIOControl. This 
title was incorrect. The title of the help topic has been changed to the correct title, 
SrvNetIoCtrl

• CPR #1498 - SrvKFMS - KFMS Libraries topic. Added pre-link commands in text to 
make them more readable. Replaced image with a clearer one.
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I.D.E.E.A. 4.3

Summary of changes

Enhancements

Changes to I.D.E.E.A. Workshop
• New Keycorp Host Emulator tool to allow simulation of an AS2805 (or ISO8583) 

acquirer host to assist with application development and debugging

• New K76 Base Station plug-in to allow simulation of the communication connection 
between a K23 pin-pad and an acquirer host using the Keycorp Host Emulator tool.

• HostEmul plug-in re-named

• I.D.E.E.A. Tutorial now available from the Start menu and the I.D.E.E.A. Workshop 
Help menu.

Changes to Embedded Components
• SrvNet

• BIOS changes for K23-3xx and K23-Mk2

• Hexpress utility update

Issues fixed
The following issues reported in I.D.E.E.A. v4.2 have been fixed in v4.3.

• Correction to HibSecureRam routine (Defect #1143)

• Removal of Automatic Sorting in the Applet Function Registration dialog 
(Defect #1144)

• Visual UI updated to include alphabet letters on K78 and K23 keypads (Defect 
#1145)

• Removal of Include paths restriction (Defect #1146)

• Bitmap Editor keyboard shortcut changes (CPR #1071 and Defect #1147)

• SrvNet project file references corrected (Defect #1149)

• COM plug-in removal problems corrected (Defect #1148)

• Missing SrvDiag libraries reinstated (CPR#1093)

• Line monitor window titles improved (CPR#1158)

• Miscellaneous Online help issues - defects #725, #767, #825, #839, #874, #875, 
#1150.
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New Keycorp Host Emulator tool
Applications written using the Keycorp Embedded Framework typically need to be tested 
with an end-to-end link with an acquirer host. This release of I.D.E.E.A. includes a new tool 
(the Keycorp Host Emulator) that can assist with development and debugging of an 
application for which a host does not exist at the time of development, or for which a 
physical connection to a host can not be made.

The Keycorp Host Emulator is a standalone tool that allows simulation of an AS2805 (or 
ISO8583) acquirer host without the need for any external hardware. It is designed to be 
used with an application under test running either as an I.D.E.E.A. simulation or on a real 
target platform.

Typically an individual acquirer host will require a unique host emulation setup. The 
Keycorp Host Emulator can be configured to meet a number of acquirer host setups, with 
configurations stored in configuration files, so that you do not have to create a specific host 
emulator for each acquirer.

The Keycorp Host Emulator provides support for:

• a range of application layer protocols  

• a range of key generation options

• a range of message encryption options

• message authentication

• MAC checking

Log windows show filtered views of the data flow within the host emulator:

• a Host log window allows you to view a single line summary of each message received 
and sent

• a Network log window allows you to view messages disassembled into bits

• a Message log window allows you to view disassembled messages, formatted with 
plain English field descriptions that match the message protocol used by the applica-
tion under test.

The Keycorp Host Emulator has its own on-line help. Refer to this for more information 
about configuring and using the tool.

New K76 Base Station plug-in
The new K76 Base Station plug-in simulates K76 internal modem functions to allow an 
I.D.E.E.A. application running on a simulated K23 pin pad to communicate with the new 
Keycorp Host Emulator tool included with I.D.E.E.A.. The plug-in communicates with the 
Keycorp Host Emulator via a TCP/IP link. The KeycorpHost Emulator IP address and port 
must be defined in the configuration for the K76 Base Station plug-in prior to running the 
simulation. By using default loop back settings in this configuration, it is possible to run 
both the K76 Base Station plug-in (under I.D.E.E.A.) and the Keycorp Host Emulator on the 
same machine.  Alternatively, you can configure the appropriate TCP/IP connection and 
settings to run the plug-in and Keycorp Host Emulator on different machines.

Currently, the K76 Base Station plug-in only simulates the K76 modem functions, and does 
not simulate the K76 printer functions. See the K76 Base Station Plug-in topic in the 
I.D.E.E.A. online help for more information about simulating printer and auxiliary port 
functions in the pinpad application. A K76 printer simulator for the K76 Base Station plug-
in will be included in a future release. 

HostEmul plug-in re-named
The HostEmul plug-in has been re-named to avoid confusion following the inclusion in 
I.D.E.E.A. of the Keycorp Host Emulator tool. The HostEmul plug-in is now known as the 
SimpleUART plug-in
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The Simple UART plug-in is a simple software tool that may be used to simulate the host 
end of a connection on a device's UART. It allows the transmission of raw data from the 
host end to the application. It is designed for simple debugging of the device application 
and is usually used in conjunction with the Line Monitor to test the application’s receipt of 
simple data transmitted from a host.

Note that this is a very simple tool which only allows for transmission of raw data from the 
host end - it does not support higher layer protocol conversion or reception of data.

I.D.E.E.A. Tutorial
The I.D.E.E.A. Tutorial is now acessible from the I.D.E.E.A. Workshop Help menu and from 
the Start > Programs > Keycorp Workshop menu.

The I.D.E.E.A.Tutorial is a hands-on guide to creating, developing, building and 
downloading an embedded application for a Keycorp Terminal.

SrvNet
The SrvNet component has been updated as follows:

• some error codes have been changed in the SrvGprs library.

• the SrvI2414 library has been changed so that 7 bit plus parity operation is now cor-
rect with the Si2414 modem as in the K78.

• the SrvUart library has been changed so that the Si2414 parity changes may be oper-
ational.

• various protocols have had a transparency introduced to their SrvIoCtrl functions.

BIOS changes for K23-3xx and K23-Mk2
The BIOS for K23-3xx and K23-Mk2 has been updated to include support for the newer 
flash chips used in some models of these terminals. Note that the new BIOS is compatible 
with all flash chips used in these terminals.

Hexpress utility update
The Hexpress compression utility has been updated and now compresses the signature 
record in a signed hex file separately from the rest of the file.

Correction to HibSecureRam routine (Defect #1143)
The HibSecureRam module was not reading a mapped file back when re-started. (Secure 
ram should be non-volatile.) The cSECURE_RAM::ReadFrom(...) routine in the pchib_dll 
module was clearing the secure ram memory regardless of whether the stored security RAM 
block was a key or not. This has now been modified so that  the secure RAM block is only 
cleared if it has been written by the WriteTo() routine with the fKeyPresent flag set. In other 
cases the secure RAM block is not cleared. Clearing the secure Ram block after reading is 
a feature of the HibSecureRamReadDesKey() function.

Removal of Automatic Sorting in the Applet Function Registration 
dialog (Defect #1144)
Currently registered applet functions displayed in the Applet Function Registration dialog 
are automatically re-sorted in ascending alphabetical order whenever a user manually 
forces the generation of Appman registration source files from this dialog. The sorting 
function in this dialog has now been disabled, to accommodate users wishing to preserve 
the order of registered functions to avoid recompiling a library update.
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Visual UI updated to include alphabet letters on K78 and K23 key-
pads (Defect #1145)
Images of K78 and 23 terminals in Visual UI now show alphabet letters as displayed on the 
real terminals they represent.

Removal of Include paths restriction (Defect #1146)
Previously the embedded make file template restricted the number of include paths that 
could be used with an I.D.E.E.A. project to 16. This restriction has now been removed.

Bitmap Editor keyboard shortcut changes (CPR #1071 and Defect 
#1147)
The following keyboard shortcuts in the Bitmap Editor tool have been modified to reflect 
standard combinations.

• Undo - Ctrl+U replaced by Ctrl+Z 

• Redo -  Ctrl+R replaced by Ctrl+Y

• Cut -  Ctrl+T replaced by Ctrl+X

• Paste -  Ctrl+A replaced by Ctrl+V

• Select All - now Ctrl+A

• Deselect All -  now Ctrl+D

SrvNet project file references corrected (Defect #1149)
In I.D.E.E.A.4.1 and 4.2, the MSVC project file for the SrvNet application 
(Apps\SrvNet\Build\SrvNetap.dsp) used some incorrect references to c:\IDEEA instead of 
c:\IDEEA4. These have been corrected.

COM plug-in removal problems corrected (Defect #1148)
In I.D.E.E.A.4.1 and 4.2, COM3 - COM8 plug-ins could not be removed using the right click 
menu in topology view. The path to the plug-in image directory was incorrectly registered 
as c:\I.D.E.E.A. instead of c:\I.D.E.E.A.4 on installation. The installation program has now 
been corrected.

Missing SrvDiag libraries reinstated (CPR#1093)
The SrvDiag libraries were inadvertently omitted from the installation of I.D.E.E.A. 4.1 and 
4.2. The installation program has now been corrected.

Line monitor window titles improved (CPR#1158)
When more than one UART is being monitored the UART Channel was sometimes obscured 
in the title bar of the Line Monitor window, making it difficult to determine which line 
Monitor window related to which UART. The format of the window title has now been 
modified so that the UART channel will always be visible.

Online help issues
• Defect #725 – additional information was added for Compiler settings in Embedded 

Project Settings. 

• Defect #767 – Help for some aspects of the old host emulator plug-in were missing in 
the online help. This plug-in has now been replaced by the Simple UART plug-in, and 
the help for this is complete.
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• Defect #825 – the incorrect prototype shown in help for the DrvGfxRegisterFont func-
tion was replaced with the correct prototype.

• Defect #839 –  references to the nonexistent SrvPrnLineFeed(2) function were 
removed from the Selecting font and setting size and Printing a Receipt exam-
ples.

• Defect #874 –  incorrect information was removed from the note in the Application 
Manager Software Architecture topic  – i.e., "The maximum number of Applications 
and Applets that can execute under AppMan is currently 16."

• Defect #875 – the Embedded Download topic was updated to reflect more accurate 
information about the default connection speed displayed when setting up an embed-
ded download.

• Defect #1150 - HIBSecureRAM functions ( HibSecureRamGetVersion(), HibSecure-
RamGetConfig(),  and HibSecureRamAllocate() ) were previously described in the 
online help as being not supported in I.D.E.E.A. These functions are now supported 
and the online help has been updated accordingly. 
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I.D.E.E.A. 4.2

I.D.E.E.A v4.2 supports all the features in I.D.E.E.A. 4.0 and I.D.E.E.A. 4.1 as well as the 
following new features. See I.D.E.E.A. v4.0 and I.D.E.E.A. 4.1.

Summary of Changes
Support for K23P-3xx products
Embedded Memory Configurator enhancements
New applet type for appman applications
Updated SrvMenu and SrvUtil service libraries
Issues fixed

Support for K23P-3xx products
I.D.E.E.A. now provides support for the K23P-3xx series of products. You can now select 
one of these products whenever you set, change or re-synchronise a device for a project.

For K23P-300, K23P-301, K23P-302, K23P-304, K23P-305 and K23P-323 products, select 
the required product directly from the device list.

For other K23P-32x products not explicitly listed in the device list, select the corresponding 
K23P-30x product (which will have compatible properties) – i.e., for K23P-322, select the 
K23P302 device.

Embedded Memory Configurator enhancements
Enhancements have been made to the Embedded Memory Configurator dialog that is used 
to help configure the memory map for appman applications. The Embedded Memory 
Configurator dialog can be accessed by clicking the Memory Configurator toolbar button in 
I.D.E.E.A. Workshop.

The Embedded Memory Configurator dialog allows you to view the current start positions 
of code and data segments for all the components within an appman application, together 
with the size of each segment, and will highlight any memory conflicts that need to be 
resolved. Once an embedded project has been built, the dialog displays total code and data 
memory requirements for the application.

Options in the dialog allow you to manually re-configure the memory usage for each 
application component. You can:

• rearrange components

• force each code or data segment to start on a new sector

• lock in existing settings for either code or data segments

• reserve specific amounts of memory for data segments

• specify blocks to avoid when automatically reconfiguring the memory map.

Alternatively, you can use the automatic configuration feature to re-configure the memory 
map.

New applet type for appman applications
I.D.E.E.A v4.2 provides support for a new applet type for appman applications. The new 
Security type applet component makes it possible to override or protect data from the usual 
HIB BIOS function calls. You can use this component to:
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• re-define HIB functions on the terminal. (Where a security type applet exists, appman 
will register a security function re-mapping of specified HIB functions as part of a 
once-only data initialisation when the applet is loaded for the first time.)

• filter all user events before they are passed to the application. (Where a security type 
applet exists, appman will pass all user events to the security applet first. The applet 
will determine if events will be passed to other components within the application.)

Note: When an HIB function is re-defined by the Security type applet, this applet has 
access to the original HIB function. All other applet/application calls to the HIB function will 
be mapped to the Security Applet definiton of the function.

Updated SrvMenu and SrvUtil service libraries
The SrvMenu and SrvUtil service libraries have been updated to include new functions.

• The SrvMenu service library has been updated to include a new function.

SrvMenuRegisterBusyWaitAuxProcFunction
Scope: Interface

Prototype: ERRNO   SrvMenuRegisterBusyWaitAuxProcFunction(ERRNO 
(*pfBusyWaitAuxProcFunction)())

Description: This function registers a function that will be executed periodically while any of 
the SrvMenu routines are cycling/waiting for input from the user.

Parameters:
PfBusyWaitAuxProcFunction

Pointer to the function to be executed periodically whilst waiting for user input. May be 
NULL if no function is to be executed.

This function must adhere to the following rules:

1. The function must not take any parameters.

2. The function must return NOERROR on success, or an ERRNO value on failure.

3. To ensure that input events are not missed, the function must be relatively 'quick' in 
execution, and should not wait for anything. For example, the function may check the 
status of various items, but it should not wait for any of them to change, and it 
certainly should not itself wait for any user input.

Returns:

NOERROR:    Operation completed successfully.

• The SrvUtil service library has been updated to include a new function.

SrvUtilRegisterBusyWaitAuxProcFunction
Scope: Interface

Prototype: ERRNO   SrvUtilRegisterBusyWaitAuxProcFunction(ERRNO 
(*pfBusyWaitAuxProcFunction)())

Description: This function registers a function that will be executed periodically while any of 
the SrvUtil routines are cycling/waiting for input from the user.

Parameters:

PfBusyWaitAuxProcFunction

Pointer to the function to be executed periodically whilst waiting for user input. May be 
NULL if no function is to be executed.

This function must adhere to the following rules:

1. The function must not take any parameters.
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2. The function must return NOERROR on success, or an ERRNO value on failure.

3. To ensure that input events are not missed, the function must be relatively 'quick' in 
execution, and should not wait for anything. For example, the function may check the 
status of various items, but it should not wait for any of them to change, and it 
certainly should not itself wait for any user input.

Returns:

NOERROR:    Operation completed successfully.

Issues fixed
Various issues reported in I.D.E.E.A. v4.0 and 4.1 have been fixed.
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I.D.E.E.A. 4.1

I.D.E.E.A. v4.1 supports all the features in I.D.E.E.A. 4.0 (see I.D.E.E.A. v4.0) as well as 
the following new features:

• I.D.E.E.A. 4.1 supports “side-by-side” installation with I.D.E.E.A. v3.X. You can now 
install I.D.E.E.A. v4.1 on a machine that already has I.D.E.E.A. v3.X installed.

• I.D.E.E.A. 4.1 includes support for Microsoft Visual C/C++ v 7.0 on Microsoft Visual 
Studio.Net as well as Microsoft Visual Studio v 5.0 and v 6.0 

• The I.D.E.E.A. 3.X security device will work with I.D.E.E.A. v4.1 without upgrade - all 
options will be enabled for I.D.E.E.A. 4.1.

• I.D.E.E.A. v4.1 may be installed on any drive or directory accessible to the machine - 
you are no longer restricted to installing it on C:\I.D.E.E.A.\.

• I.D.E.E.A. v4.1 includes a new status display for the Remote Terminal on the 
I.D.E.E.A. Workshop window. Users may now disable or enable the use of the Remote 
Terminal in a project through the Configure Simulator dialog (Debug > Configure Sim-
ulator menu from the Topology View).

Bugs reported in I.D.E.E.A. v4.0 have been fixed.
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I.D.E.E.A. v4.0

• I.D.E.E.A. introduces a new I.D.E.E.A. Workshop front end similar to Microsoft Visual 
Studio.

• I.D.E.E.A. 4.0 has the ability to manage and simulate projects with multiple applica-
tions and applets within the APPMAN environment.

• New user friendly project wizards help both novice and experienced application devel-
opers build new projects quickly.

• Short cut keys and an integrated output window allow experienced users to build mul-
tiple applications with a single keyboard stroke and view the embedded build results in 
a single window.

• New Memory Configurator tool allows you to configure memory usage for multiple 
applications under the APPMAN environment; both automatic and manual configura-
tion options are available which will save application development time spent manipu-
lating memory maps for multiple applications.

• I.D.E.E.A. provides full APPMAN environment variable support, allowing user friendly 
editing, PC simulation and target platform download.

• A new integrated application loader allows complete applications to be loaded to the 
target platform including the APPMAN operating system, APPMAN environment varia-
bles, and APPMAN applications and applets as well as standalone applications. All APP-
MAN components can be loaded in one go! 

• A new Appman Apps registry means you do not need to copy DLLs during simulation 
and can now avoid the frustration of forgetting to copy one during debugging.

• I.D.E.E.A. 4.0 supports MD5 signature generation on the application and loading of 
signed application to the target platform.

• I.D.E.E.A. 4.0 supports application compression and loading of the compressed appli-
cation to target platform.

• I.D.E.E.A. 4.0 now supports relative paths within projects; you may now copy 
I.D.E.E.A. projects without using the Replicator tool; the duplicated project will work 
with minimal changes to the header file and libraries Include paths

• I.D.E.E.A. 4.0 has been tested on the following PC platforms

• Windows 98

• Windows NT 4.0 with SP6a

• Windows 2000 with SP3

• Windows XP

• The new up-to-date installation technology allows for easy upgrade and maintenance 
of your I.D.E.E.A. installation; and you may now set up your workstation to allow mul-
tiple users to use your I.D.E.E.A. installation locally under the Windows NT, 2000 or XP 
operating systems.

• New options have been added to enhance your terminal’s capabilities.



I.D.E.E.A. v4.0

24



I.D.E.E.A. Package Options

25

I.D.E.E.A. Package Options

The following I.D.E.E.A. packages are available from release v4.0 onward.

Depending on the I.D.E.E.A. package you have purchased, your package will include:

• Installation media: CD-ROM or installation files (all packages)

• A parallel port security key (dongle) – (Base and Full packages)

• Product ID: a 32-digit hexdecimal number labelled on the security key or CD-ROM, or 
stored with the installation media in a file – (all packages).

I.D.E.E.A. Full Package
The I.D.E.E.A. Full Package contains all I.D.E.E.A. features and tools for application 
development and simulation in the PC environment and for compiling and downloading to 
the target platforms (i.e., Keycorp’s Access Device products). The I.D.E.E.A. Full Package:

• includes the basic Keycorp Embedded Framework (KEF) libraries 

• includes installation files for the following Options:

• IAR Embedded Compiler – a Commercial C language compiler for embedded 
applications. (This requires a separate licence from IAR.)

• Advanced KEF Libraries – additional libraries

• EMV Libraries (certified EMV smart card libraries)

The options that are available for installation depend on the settings within your 
security device. All authorised I.D.E.E.A. users have all the above options enabled in 
their security device. 

• requires a security device (dongle) to install or run the software. 

Note: I.D.E.E.A. Options may not be installed alone. You must install the I.D.E.E.A. Base 
Package before you can install I.D.E.E.A Options.

I.D.E.E.A. Base Package
The I.D.E.E.A. Base package is the same as the I.D.E.E.A. Full Package without Options 
installation files. You can upgrade the I.D.E.E.A. Base Package to the Full Package by 
adding the Options installation files and enabling the options in the security device.

The I.D.E.E.A. Base Package:

• includes the basic Keycorp Embedded Framework (KEF) libraries

• requires a security device (dongle) to install or run the software. 

I.D.E.E.A. Demo Package
The I.D.E.E.A. demonstration package provides all the features required to develop and 
simulate applications for Keycorp’s Access Device products under the PC environment. 
However, it does not allow you to compile an embedded version of an application or 
download an embedded application into Keycorp’s Access Device products

The I.D.E.E.A. Demo Package:

• does not include the Keycorp Embedded Framework (KEF) library

• does not include I.D.E.E.A. Options

• does not require a security device (dongle) to install or run the software
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System Requirements

To install I.D.E.E.A. you need the following:

Hardware
Pentium personal computer with 90 MHz or higher processor

64 MB of RAM minimum

120MB of hard disk space minimum for a complete installation

Software
Microsoft Visual Studio .Net (Microsoft Development Environment v7.0) with Microsoft 
Visual C++ .Net

OR

Microsoft Visual Studio 6.0 with Microsoft Visual C++ 6.0 (recommended)

OR

Microsoft Visual C++ 5.0 (minimum)

Operating Systems Supported
• Windows 98

• Windows NT 4.0

• Windows 2000

• Windows XP
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Before you Install I.D.E.E.A.

If you have an older version of I.D.E.E.A.
• I.D.E.E.A. v4.4 will replace installed versions of I.D.E.E.A. v4.x.

I.D.E.E.A. v4.4 detects if you have an installed version of I.D.E.E.A. v4.x and will 
prompt you to remove it.

• I.D.E.E.A. v4.4 is compatible with I.D.E.E.A. v3.x and both versions may be installed 
on the same machine. However, they should not be run at the same time.

• I.D.E.E.A. v4.4 is not compatible with I.D.E.E.A. v1.x or v2.x. These must be unin-
stalled before you install I.D.E.E.A. v4.x.

Windows Installer
The I.D.E.E.A. installation uses Windows Installer, the Microsoft installation software that 
comes with the latest Windows operating systems. 

If you are installing I.D.E.E.A. v4.x for the first time, Windows Installer v2.0 may not be 
available on your machine. 

If you have a version of Windows Installer older than v2.0, your version may need to be 
updated to v2.0.

If the correct version of Windows Installer is available, the Installer will automatically open 
the I.D.E.E.A. Workshop Setup window when you insert the I.D.E.E.A. 4.4 CD into your 
computer's CD-ROM drive. 

If your setup program does not start automatically after few seconds, use Windows 
Explorer to locate the CD-ROM drive containing the I.D.E.E.A. CD and double-click 
I.D.E.E.A.4Setup.exe. If Windows Installer v2.0 is not available on your machine, this 
setup program will automatically install it or update an older version. Windows Installer 
only needs to be installed once - subsequent installations of I.D.E.E.A. will not re-install 
Windows Installer. 

Note: You may need to re-start your machine after the Windows Installer installation.

Security Device
If you are installing the I.D.E.E.A. Full Package or I.D.E.E.A. Base Package, you require a 
security device (dongle) to install or run the software. Before you start the installation, turn 
off the computer and attach the I.D.E.E.A. dongle firmly onto the parallel port of your PC. 
Then power on the computer.
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How to Install I.D.E.E.A.

Perform the following steps…
1. Make sure you have exited all Windows programs.

2. Insert the I.D.E.E.A. 4.4 CD into your computer's CD-ROM drive.

The Windows Installer will automatically start.

Note: You must remove any other I.D.E.E.A. 4.x installation before installing 
I.D.E.E.A. 4.4. 

If the Windows Installer detects that you still have I.D.E.E.A. v4.x installed, it will 
display a message to prompt you to remove it before installing I.D.E.E.A. 4.4. 
Click OK to exit the installation program. Remove the current installation before you 
re-attempt installation of I.D.E.E.A. 4.4.

3. After a few moments, the I.D.E.E.A. Workshop Setup window will be displayed.

Tip: If the setup program does not start automatically after few seconds, use 
Windows Explorer to locate the CD-ROM drive containing the I.D.E.E.A. CD and 
double-click I.D.E.E.A.4Setup.exe.

4. Follow the on-screen instructions to complete the installation. 

Note: The installation program will guide you through the installation process through 
a series of setup windows. 
To exit at any time during the setup process click Cancel. 
Then click Exit Setup to quit the setup program or click Resume to continue with the 
installation.

5. If you are installing the I.D.E.E.A. Full Package or Base Package, enter the Product ID 
that comes with the package when prompted.

6. Select or change the destination folder for the installation when prompted. 
C:\I.D.E.E.A.4 is the default installation directory.

7. Select an installation type when prompted. We recommend that you select the 
Complete installation type. 

8. Click Next to begin installing I.D.E.E.A. Workshop. You will be able to view progress 
as the installation proceeds. 

9. The Setup program will notify you when I.D.E.E.A. Workshop has been successfully 
installed.

• you are installing the I.D.E.E.A. Base Package, proceed to Step 11. 

• If you are installing the I.D.E.E.A. Full Package, you will be prompted to install the 
Options Pack after the Base Package is installed. 

10.Click Install Option to start the Options installation process. 

Follow the on-screen instructions to complete the installation.

11.Click Finish to complete the installation.

12.At the end of I.D.E.E.A. installation, you will be prompted to re-start your machine. 

Ensure that you re-start before you use I.D.E.E.A. Workshop. Your I.D.E.E.A. 
installation is not completed until you have restarted your machine.

Removing an old version of I.D.E.E.A.
Remove an existing incompatible I.D.E.E.A. installation from the Add/Remove Programs 
option at the Control Panel. (You may need to remove an old version of I.D.E.E.A. before 
installing your new version.)
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Perform the following steps…
1. Select Settings  >  Control Panel from the Start menu.

2. Double-click on the Add/Remove Programs icon to open the Add/Remove Program 
Window.

3. Select I.D.E.E.A. Workshop from the list of currently installed programs.

4. Click on the Change/Remove button to start the I.D.E.E.A. Workshop Setup 
program.

5. Select Remove, then click Next.
The I.D.E.E.A. Workshop Uninstall window will open. 

6. Click Next to confirm that you want to remove I.D.E.E.A. Workshop. You will be able 
to view progress as the uninstall proceeds. 

7. The Setup program will notify you when I.D.E.E.A. Workshop has been successfully 
uninstalled.

8. Click Finish.
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Frequently Asked Questions

Why should I upgrade to I.D.E.E.A. v4?
Although I.D.E.E.A. v3 is quite capable of handling standalone application development, it 
falls short on supporting APPMAN application development. I.D.E.E.A. v4 is targeted at 
providing an easy to use environment for APPMAN, a multi-application environment. 
I.D.E.E.A. v4 simplifies the use of APPMAN to allow developers to focus on developing their 
application rather than spending time trying to understand the mechanism behind APPMAN. 
The result is a faster APPMAN application development cycle.

I.D.E.E.A. v4 fully supports the simulation of applications/applets under APPMAN 
environment on a PC - even the APPMAN environment variables can be configured and 
simulated. I.D.E.E.A. v4 also integrates the process of downloading to the target platform 
- you can now configure I.D.E.E.A. to download your APPMAN, applications, applets and 
environment variable settings all in one go. 

I.D.E.E.A. v4 still supports the traditional standalone application and library development 
as in I.D.E.E.A. v3.

Can I use I.D.E.E.A. v4.3 with I.D.E.E.A. v3.X and other I.D.E.E.A. v4.x 
versions?
I.D.E.E.A. v4.3 is made to be compatible with I.D.E.E.A. v3.x to facilitate the migration of 
I.D.E.E.A. v3 projects to I.D.E.E.A. v4. 

However, I.D.E.E.A. v4.3 is not compatible with other I.D.E.E.A. v4.x versions. You will be 
prompted to uninstall I.D.E.E.A. v4.0, v4.1 or 4.2 prior to installing v4.3. 

To remove I.D.E.E.A. v4.0, v4.1 or 4.2, simply go to the Window’s Control Panel and click 
the "Add/Remove Programs" icon, then select "I.D.E.E.A. Workshop" from the list.  You will 
also need to remove the I.D.E.E.A. Option Pack if it has been installed. DO NOT simply 
rename or move the existing I.D.E.E.A. directory or delete the I.D.E.E.A. registry - doing 
so will not uninstall I.D.E.E.A. properly.

How do I remove I.D.E.E.A. v3.X?
To remove I.D.E.E.A. v3.x, remove the service packs first.  To remove I.D.E.E.A. v3 service 
packs, go to the Windows Control Panel and click the "Add/Remove Programs" icon, then 
select and remove the appropriate service pack from the list. (You may need to select the 
ROLL-BACK radio button on the un-installation screen (it is NOT selected by default) to 
remove the service packs.) Repeat for every I.D.E.E.A. service pack that you may have 
installed. You may remove I.D.E.E.A. v3.0 installation after all the service packs have been 
removed.

How do I start I.D.E.E.A. v4.3?
You can start I.D.E.E.A. Workshop v4.3 from the Start menu under Keycorp Workshop 
group or you may click on an I.D.E.E.A. project “.EEP” file in Windows Explorer. Note that 
you can also access I.D.E.E.A. Tools, I.D.E.E.A. On-line help and the  I.D.E.E.A. Tutorial 
directly from the Start menu.

Can I open I.D.E.E.A. v3 projects in V4.3?
Yes, I.D.E.E.A. v4.3 will automatically detect and I.D.E.E.A. v3 project file and prompt the 
user to convert. Click YES when prompted to convert the project file to v4 format. The 
original v3 project file will be kept as a back up. 

Since I.D.E.E.A. v3 can not read I.D.E.E.A. v4 project files, it is recommended that you 
replicate the project using the v3 Project Replicator before converting it to v4 format. The 
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I.D.E.E.A. v3 Project Replicator tool is still available in your I.D.E.E.A. v4 installation under 
\I.D.E.E.A.\Tools\Replicator\ directory.

Conversion of Appman projects is slightly more complicated. First take care to replicate 
your v3 projects into the v4 project structure, then create your v4 main project at the main 
project directory level. Replicated v3.0 sub-projects can be added to the main project using 
the Project > Add Existing menu option. You may need to "synchronise" the device selected 
for the APPMAN projects after the conversion, since sub-projects may have a different 
device to the main project. We recommend that you synchronise devices using the Product 
> Change Device option after the conversion. You may select the same device as the 
current selection in the main project (device synchronisation) or select a different device.  
However, synchronising device selection will change the build addresses on all sub-projects 
to the default values.  To avoid memory conflicts, please check the build addresses on 
every sub-project after changing device selection. This is not necessary when the 
Automatic Memory Configuration function is available and has been selected.

What about I.D.E.E.A. v2.X projects, can I open them? 
I.D.E.E.A. v4 does not support I.D.E.E.A. projects created prior to v3. If you have an old 
project created with I.D.E.E.A. v2.X or earlier, you must convert it to v3 format first (i.e., 
by opening it in I.D.E.E.A. v3) then convert to I.D.E.E.A. v4 format.

Is there any different between the v3 project structures and v4 
project structures?
Yes, but it is minimal. In order to manage sub-projects in I.D.E.E.A. v4, there are some 
changes to APPMAN project structures, but there is absolutely no change to the stand-
alone, library project structures or even the project structures within APPMAN applications 
and applets. In I.D.E.E.A. v4, all sub-projects (APPMAN Applications or APPMAN Applets) 
must be located under the same directory, that is the main project directory. When first 
created, the main project directory has nothing except the main project file and the sub-
project directories. The contents in the sub-project directories are the same as in V3 (i.e., 
Build, DLL, Source, and Include sub-directories. As you compile the embedded projects, 
other files may be generated in the main project directory. You can safely ignore those files 
as they are generated by I.D.E.E.A..

I want to demonstrate my application on I.D.E.E.A. to a customer. 
Can I run I.D.E.E.A. without a dongle and MSVC?
Yes. Install the Demo version of I.D.E.E.A. and configure the simulator to start simulation 
with the ready built EXE.  To configure the simualator, select Debug  > Configure Simulator 
from the menu then enable the “Start application simulation automatically” check box and 
enter the path to the ready built executable file.  For a standalone project, the ready built 
executable file is the one you build under MSVC (may be from another machine) for 
simulation.  For an Appman project, the ready built executable file is the Appman.exe in 
I.D.E.E.A.4\Bin directory. You must have all the Appman applications and applets ready 
built (as DLLs) in your project directory.

I can’t find the menu, it seems to disappear!
Menus on I.D.E.E.A. v4 change dynamically with the context. In other words, if you focus 
on the Project View, project view menus will be displayed, if you focus on the Topology 
View, topology view menus will be displayed. The Output View pops up automatically when 
you start the embedded compilation or with the selection of the View > Output menu item. 
The Output menu also will be displayed with the Output View when it is in focus. Each View 
has its own dedicated menu functions, and common menu functions are available for all 
views. Some Views also have right-click (pop-up) menus for quick access to frequently 
used functions.
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Where is the Project Replicator?
I.D.E.E.A. v4 is able to store information in the project files with “smart” relative paths. As 
a result, you can now move or copy entire project trees using Windows Explorer.  The 
Project Replicator in v3 has become obsolete. However, in order to support existing 
projects built with I.D.E.E.A. v3, the Project Replicator will be kept in the TOOLS directory 
within the I.D.E.E.A. installation. 

What is the Memory Configurator?
The Memory Configurator is a new tool introduced in I.D.E.E.A. v4 to assist application 
developers to configure CODE and DATA segments for APPMAN applications created under 
the same APPMAN project. The Memory Configurator displays the memory usage of 
applications and applets in an APPMAN project after they have been successfully compiled.   
It also provides options for developers to configure the CODE and DATA memory segment 
to avoid memory conflicts between applications / applets.  It places your application code 
on a separated flash memory boundary automatically to avoid being erased when 
attempting to erase another application. It also configures your application’s RAM usage to 
avoid memory conflict and can be configured to leave gaps between applications to allow 
for future upgrades. The Memory Configurator is a very useful tool for developing 
applications or applets under the APPMAN environment. See the I.D.E.E.A. on-line help for 
more information.

What is APPMAN Apps Registry?
This is a new feature on I.D.E.E.A. v4. I.D.E.E.A. v3.0 users may recall that they had to 
copy DLLs generated for APPMAN applications or applets simulation every time they re-
compiled the project on PC. 

In I.D.E.E.A. v4.0, this is no longer necessary provided you register the Apps (applications 
or applets) with I.D.E.E.A.. Once the Apps are registered, I.D.E.E.A. v4 will load the DLL 
from the project’s DLL sub-directory automatically when you start an APPMAN simulation. 
If you do not have a Display Applet in your project (you need one for every APPMAN 
project), you may also choose a ready-made display applet from the APPMAN Apps registry 
and I.D.E.E.A. will use it for APPMAN display.

Is there any change to the Applet Function Registry?
No, it is basically the same as for I.D.E.E.A. v3 except it looks slightly different. As in 
I.D.E.E.A. v3, you need to register or expose a function in an applet to allow other 
applications or applets to use it under APPMAN’s environment. Simply select an applet 
header file with the function prototype, than add the required function to the "Registered 
functions" box. I.D.E.E.A. will do the rest for you.

Can I control the order of compilation or download within an APP-
MAN project?
Yes, simply re-order the sub-projects in the Project View using the window’s "drag-and-
drop" operation. The order of sub-project you see on the Project View is the order of 
compilation. The order of compilation will be important for Automatic Memory 
Configuration. The order of download can be changed in the APPMAN DOWNLOAD dialog 
by adding and removing the sub-projects in the project selection boxes. The order you see 
in the "Selected projects" box is the order of download for APPMAN applications and 
applets. APPMAN itself is always downloaded first, if enabled, followed by APPMAN variables 
and APPMAN apps (applications or applets).
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Where are the REMOTE and SCT plug-ins?
I.D.E.E.A. v4 has re-defined the term "plug-in" in I.D.E.E.A. to avoid the confusion that 
many application developers experienced - especially first time users. From I.D.E.E.A. v4 
onward, "plug-ins" refers to the optional components or devices which users can physically 
connect to the available UART ports. The available plug-ins on I.D.E.E.A. v4 are printers, 
line monitors, host emulators and PC COM ports. 

REMOTE and SCT are now an integrated part of I.D.E.E.A. (from users point of view) for 
terminal simulation. Users can configure REMOTE and SCT from the Tools > Options menu 
but they no longer need to add REMOTE or SCT to the topology.  Since most (if not all) the 
SCT functions are emulated on REMOTE terminals, the configuration of REMOTE and SCT 
are very much "tied" together.  Experiment with this yourself by "touring" the Workshop’s 
Options dialog.  The check box at the bottom of the Smart Card Browser page will 
determine whether the Smart Card Browser will be displayed when the simulator starts.

Do I need to export the MSVC make file for I.D.E.E.A.?
No, I.D.E.E.A. v4 is smart enough to read the latest DSP file, if it is available, in the project 
directory. So, next time you add a new C file to your project, you don’t need to remember 
to export the make file or experience frustrations during debug.  However, you do need to 
refresh the I.D.E.E.A. display to display the newly added C file by re-building the embedded 
project or reload the entire project. 

Can I rename APPMAN application or applet projects?
Yes, but not completely!  Renaming a project is never an easy matter as the name is used 
everywhere in the project.  I.D.E.E.A. v4 does provide you with the facility to rename 
APPMAN applications or applet projects under the Project menu, but it only renames the 
embedded targets of the project NOT the MSDev part used for simulation NOR the long and 
short names in the application header.  Experiment yourself and look into the Embedded 
settings after the renaming.

You should use this feature with caution as it may cause confusion in the long term as 
different names are being used in the same I.D.E.E.A. project.

Depending on the purpose of renaming a project, there are other ways to change the 
names of an existing project.  The safest and most comprehensive way is to create a new 
project with a different name than copy the source files and settings into the new project.  
Another way is to use the original name in the I.D.E.E.A. project and simply rename the 
binary file (*.hex) in the Embedded > Settings’s build tab. This changes change the name 
of the target binary file only and leaves all others with their original names.

Does I.D.E.E.A. support LAN topology (multi-drop RS485 layout)?
Yes, the final release of I.D.E.E.A. v4 has implemented RS485 host connection support, 
previously known as the LAN topology, on those products with a RS485 host port.  In 
I.D.E.E.A. v4, you do not need to worry about which topology (LAN vs UART) to use - 
I.D.E.E.A. will load the correct layout for the product of your choice. 

Fault Reports and Suggestions

If I find a fault in I.D.E.E.A. v4, where do I report it? If I have a sug-
gestion, who should I talk to?
The Keycorp I.D.E.E.A. support web page http://www.keycorp.net/technicalsupport/
default.htm will direct you to the solution for any known problems. 

If you have any suggestions or fault reports, please email to I.D.E.E.A. technical support 
(technicalsupport@keycorp.net) or submit it through the I.D.E.E.A. Support pages at 
Keycorp’s web site http://www.keycorp.net .

http://www.keycorp.net 
http://www.keycorp.net/ideeasupport/default.htm 
http://www.keycorp.net/ideeasupport/default.htm 
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